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Important Notice
Frame Technology® Corporation (Frame®) and its licensors 
retain all ownership rights to the FrameMaker® computer 
program and other computer programs offered by Frame 
(hereinafter collectively called “Frame Software”) and their 
documentation. Use of Frame Software is governed by the 
license agreement accompanying your original media. The 
Frame Software source code is a confidential trade secret of 
Frame. You may not attempt to decipher or decompile Frame 
Software or develop source code for Frame Software, or 
knowingly allow others to do so. Information necessary to 
achieve the interoperability of the Frame Software with other 
programs may be available from Frame upon request. You may 
not develop passwords or codes or otherwise enable the Save 
feature of Frame Software. Frame Software and its 
documentation may not be sublicensed and may not be 
transferred without the prior written consent of Frame.

Only you and your employees and consultants who have agreed 
to the above restrictions may use Frame Software (with the Save 
feature enabled), and only on the authorized equipment. 

Your right to copy Frame Software and this publication is limited 
by copyright law. Making copies, adaptations, or compilation 
works (except copies of Frame Software for archival purposes or 
as an essential step in the utilization of the program in 
conjunction with the equipment), without prior written 
authorization of Frame, is prohibited by law and constitutes a 
punishable violation of the law.

FRAME TECHNOLOGY CORPORATION PROVIDES THIS 
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT 
LIMITED TO THE IMPLIED WARRANTIES OR CONDITIONS 
OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. IN NO EVENT SHALL FRAME BE LIABLE FOR 
ANY LOSS OF PROFITS, LOSS OF BUSINESS, LOSS OF USE 
OR DATA, INTERRUPTION OF BUSINESS, OR FOR 
INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL 
DAMAGES OF ANY KIND, EVEN IF FRAME HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES 
ARISING FROM ANY DEFECT OR ERROR IN THIS 
PUBLICATION.

Frame may revise this publication from time to time without 
notice. Some states or jurisdictions do not allow disclaimer of 
express or implied warranties in certain transactions; therefore, 
this statement may not apply to you.

Copyright 1986–1993 Frame Technology Corporation. All 
rights reserved.

In the United States, Frame, the Frame logo, FrameMaker, 
FrameReader, Frame Technology, and FrameViewer are 
registered trademarks, and FrameBuilder, FrameMaker 
International Dictionaries, FrameMath, FrameServer, and 
FrameWriter are trademarks, of Frame Technology Corporation.

The following are trademarks or registered trademarks of Frame 
Technology Corporation in countries outside of the United 
States: Frame, the Frame logo, FrameBuilder, FrameMaker, 

FrameMaker International Dictionaries, FrameMath, 
FrameReader, FrameServer, Frame Technology, FrameViewer, 
and FrameWriter.

The MacLink Plus translators included with the Macintosh 
version of Frame software are licensed from DataViz Inc.  
1984, 1993 DataViz Inc. All rights reserved.

PANTONE® Computer Video simulation used in Frame Software 
may not match PANTONE-identified solid color standards. Use 
current PANTONE Color Reference Manuals for accurate color. 
PANTONE Color Computer Graphics Pantone, Inc. 1986, 
1988.

The spelling and thesaurus portions of Frame Software are 
based on THE PROXIMITY LINGUISTIC SYSTEM  1992 
Proximity Technology Inc.; C.A. Stromberg AB; Espasa-Calpe; 
Hachette; IDE a.s.; Kruger; Lluis de Yzaguirre i Maura; Merriam-
Webster Inc.; Munksgaard Int. Publishers Ltd.; Nathan; Text & 
Satz Datentechnik; Van Dale Lexicographie bv; William Collins 
Sons & Co. Ltd.; Zanichelli. All rights reserved.

The installer software used by the Windows version of Frame 
Software is based on the Microsoft Setup Toolkit 1992 
Microsoft Corporation.

The following are trademarks or registered trademarks of their 
respective companies or organizations:

Adobe, Adobe Type Manager, ATM / Adobe Systems Inc.

Apple, AppleTalk, Macintosh, LaserWriter, ImageWriter, Finder, 
MultiFinder, TrueType, QuickDraw, MacroMaker / Apple 
Computer, Inc.

ImageStream Graphics Filters / ImageMark Software Labs, Inc.

Proximity, Linguibase / Proximity Technology Inc.

Sun Microsystems, Sun Workstation, TOPS, NeWS, NeWSprint, 
OpenWindows, TypeScaler, SunView, SunOS, NFS, Sun-3, 
Sun-4, Sun386i, SPARC, SPARCstation / Sun Microsystems, 
Inc.

All other brand or product names are trademarks or registered 
trademarks of their respective companies or organizations.

Any provision of Frame Software to the US Government is with 
“Restricted Rights” as follows: Use, duplication, or disclosure by 
the Government is subject to restrictions set forth in 
subparagraphs (a) through (d) of the Commercial Computer-
Restricted Rights clause at FAR 52.227-19 when applicable, or 
in subparagraph (c)(1)(ii) of the Rights in Technical Data and 
Computer Software clause at DFARS 252.227-7013, and in 
similar clauses in the NASA FAR Supplement. Any provision of 
Frame Software documentation to the US Government is with 
Limited Rights. The contractor/manufacturer is Frame 
Technology Corporation, 1010 Rincon Circle, San Jose, CA 
95131. 

US versions are printed in the United States; international 
versions are printed in Ireland.
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1 Introduction 1
Frame® filters are programs that convert document and graphics files from one format to 
another format that Frame products can use. A document file contains information created 
with a word processor or publishing application; a graphics file primarily contains a picture. 

About filters
There are two types of filters:

• Document filters allow you to convert document files that were created with other 
applications into Frame product documents. The files may contain graphics. You 
convert document files by opening them with the Frame product Open command.

Through the Windows Clipboard or the Save As command, the document filters also 
allow you to export Frame documents to other applications in RTF format.

• Graphics filters allow you to import graphics created with other applications into Frame 
documents. 

Through the Windows Clipboard, the graphics filters also allow you to export Frame 
graphics to other applications in BMP or WMF format.

Filters are located in the directory where your Frame product is installed. You can choose 
whether to install filter files when you install a Frame product. If you did not install filters, 
you’ll need to run the Installer again. For more information about installing Frame products 
(including filters), see Getting Started. 

Graphics filters use information in filter initialization files (.ini files). You can change 
settings in .ini files, as described in Chapter 4, “Converting Graphics.”

How filters work
When you use a Frame product to open a document file created with another application, 
the appropriate Frame filter translates from the application’s internal format into Maker 
Interchange Format (MIF). MIF is then used to display the file as a Frame document. 
Using Frame Filters 1
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The filters create a temporary MIF file and delete it after the Frame document is created. If 
you need to create a MIF file from a converted document, use the Frame product Save As 
command and choose Interchange-MIF from the Format pop-up menu.

When you use the Frame product Import command to import a graphics file from another 
application into a Frame document, the appropriate Frame filter translates the graphics to 
a format Frame products can open and import.

Frame filters also allow you to export documents and graphics from Frame products to the 
Windows Clipboard, from which you can paste them into other applications. For details on 
formats that can be exported, see “Supported formats,” next.

Supported formats
You can convert documents and graphics from the formats listed in the following tables. Two 
asterisks (**) indicate that a format can be exported to the Windows Clipboard.

Document formats

Format Versions supported

Ami Pro Releases 2.0, 3.0

ASCII FM ASCII; Win ANSI

DisplayWrite/DCA RFT Releases 4, 5

Maker Markup Language (MML) Not applicable

Microsoft Word DOS releases 4.0, 5.0, 5.5
Macintosh releases 3.0, 4.0, 5.0, 5.1
Windows releases 1.x, 2.x

Rich Text Format (RTF)** Releases 0, 1

Ventura Publisher Releases 3.0, 4.0

WordPerfect DOS releases 4.2, 5.0, 5.1
Macintosh releases 2.0
Windows releases 5.0, 5.1

Application 
file

Temporary 
MIF file

Frame 
document

Frame Open 
command

Frame filter
Introduction 2
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Graphics formats

Converting from unsupported formats
If you need to convert files that are in formats for which Frame products have no specific 
filter, you may be able to save the files to a format recognized by one of the filters (for 
example, WMF or RTF). You can then convert them from that format into Frame documents. 
Check to see if your application can save files in a different format. It might be an option in 
the application’s Save command, or you might have to use a separate program to convert 
the file. An application’s conversion programs are often on a separate disk in the installation 
package. To find out where the conversion programs are, refer to your application’s 
reference manual.

Format Applications/versions supported

AutoCAD Drawing Interchange 
Format (DXF)

AutoCAD releases 10, 11, 12

Bitmap (BMP)** Windows releases 3.0, 3.1

CompuServe Graphics 
Interchange Format (GIF)

Release 87a

Computer Graphics Metafile 
(CGM)

ANSI Standard (ISO8632, ANSI X3.12201986)

CorelDRAW (CDR) Release 3

Digital Research Graphic File 
Format (GEM)

Release 3

Encapsulated PostScript (EPSI, 
EPSF, EPS)

ASCII, TIFF, or WMF preview; releases 1.3–3.0

Hewlett-Packard Graphics 
Language (HPGL)

HPGL release 2

IGES Release 4

Macintosh QuickDraw (PICT) Releases 1, 2

MacPaint PackBits Compression

Micrografx Designer (DRW, GRF) Draw release 3.0, Designer release 3.1, Charisma 
release  2.1

Sun raster All releases 

Tag Image File Format (TIFF) Releases 5.0, 6.0

WordPerfect Graphics (WPG) Raster and vector; WPG release 1

Windows Metafile (Aldus Header) Windows releases 3.0, 3.1

Windows Metafile (WMF)** Windows releases 3.0, 3.1

X Windows (XWD) Release X11

Zsoft PC Paintbrush Bitmap 
(PCX)

Releases 2.5, 2.8, 3.0; 8-bit, 24-bit
Using Frame Filters 3
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2 Converting Documents 2
This chapter describes basic conversion steps, how to prepare files for conversion, how to 
convert document files, how to save converted documents, how graphics within document 
files are converted, and how specific file formats are converted.

Basic conversion steps
The basic conversion steps are as follows:

1. Prepare the file and graphics for conversion.

2. Convert the file into a Frame document.

3. Save the converted document.

4. Touch up the converted document.

Steps 1 through 3 are described in this chapter. Step 4 is discussed in Chapter 3, “Touching 
Up Converted Documents.”

Preparing files for conversion
The filters convert most features of the source files into equivalent Frame product features. 
For best results, follow these suggestions for preparing files before converting them:

• Avoid using tricks that force the application to simulate functions it does not naturally 
perform. For example, using negative indents to create side headings can make 
conversion more difficult.

• Use defined styles rather than local format overrides whenever possible.

• The filters assign the first column layout column setting in the source file to all body 
pages in the converted document. It is easier to touch up converted documents that 
have more than one column layout if the most frequently used column layout is the 
first one in the source file. 

Before converting, see the following table to find out what you should rework before 
converting and which features cannot be converted. The most commonly used features are 
listed in alphabetical order.

Rework this item In this way

Absolutely positioned graphics 
(equivalent to Frame product 
unanchored frames)

If possible, change to floating graphics 
(equivalent to Frame product anchored 
frames). See “Absolutely positioned graphics” 
on page 14.
Using Frame Filters 5
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Automatic text-wrap around graphics Not converted. See “Automatic text-wrap 
around graphics” on page 14.

Column layout Specify the most frequently used layout first. 
See “Column layout” on page 15.

Drop caps Not converted. See “Drop caps” on page 16.

Equations Not converted. See “Equations” on page 17.

Format overrides Use defined styles for formatting. Avoid 
excessive use of local format overrides.

Hard new lines used to force page 
breaks

Replace with hard page breaks.

Microsoft Word files saved with the Fast 
Save option

Save files with the regular Save option.

Page orientation Try to use only one page orientation (either 
portrait or landscape) per document.

References to or definitions of objects 
located outside a header, footer, or 
footnote

If you begin defining an object within a header, 
footer, or footnote, finish the definition within 
the same header, footer, or footnote.

Rotated text Converted to regular text. See “Rotated text” 
on page 18.

Shading, line drawings, or graphics 
characters used to simulate table or 
paragraph borders

Delete.

Side headings Not converted. See “Side headings” on 
page 19.

Spaces used to simulate tab stops or to 
align text

Delete the spaces. Add tab stops in the 
application before converting, or in the Frame 
product after converting.

Tabs or spaces used to create 
paragraph indents

Replace tabs or spaces with the application’s 
paragraph indentation before converting, or 
with the Frame product’s paragraph 
indentation after converting.

Ventura Publisher files See “Preparing Ventura Publisher files,” next.

Vertical alignment Not converted. See “Vertical alignment” on 
page 26.

WordPerfect Master Doc/Subdoc file 
references

Expand WordPerfect master documents.

Rework this item In this way
Converting Documents 6
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Preparing Ventura Publisher files

You may have to modify Ventura chapter files before you can convert them. The filter does 
not automatically convert text stored in other word processing formats that are referenced 
by a Ventura chapter. 

To convert native word processing files to text:

1. Start Ventura Publisher and open the chapter file.

2. Select the various text flows that contain referenced text from other word processing 
files.

3. Choose the File Type/Rename command from the Ventura Frame menu.

4. Select ASCII as the Text Format and click OK.

5. Save the chapter file.

Preparing graphics files

Ventura chapter files often include references to external graphics files. These files remain 
in their native format. To appear in a converted Frame document, these graphics files must 
be in a format that Frame products recognize (for example, EPS or PCX). 

Bitmap formats Frame products can import are BMP, PCX, WPG (created by WordPerfect 
Graphics), MacPaint, TIFF, GIF, XWD, and Sun raster. Bitmaps can be black and white, 
gray-scale, or color.

Vector file formats Frame products can import include WMF (Windows Metafile), DXF 
(created by AutoCAD), DRW and GRF (created by Micrografx Designer and Charisma), 
WPV (created by WordPerfect Vector), Macintosh QuickDraw (PICT), IGES, HPGL, and 
CGM. Vector files can be black and white, gray-scale, or color.

Before you convert a chapter file:

1. Convert all external graphics files to a format that Frame products recognize.

2. Start Ventura Publisher and open the chapter file.

3. For each graphics file you converted, make sure the chapter file refers to the new 
version of the file, not the old one.

4. Save the chapter file.

If you don’t convert graphics files to a format recognized by Frame products, gray boxes 
appear in place of the graphics when you open the converted document in Frame products. 

Checking for anchored frames

The Ventura Publisher filter converts both anchored and unanchored frames. However, 
because of differences in font metrics, paragraph spacing, and so on, unanchored frames 
may appear in slightly different locations after the document is converted. Also, Frame 
products do not support graphics with automatic text wraparound. After you convert a 
document, you may have text hidden under an unanchored frame. Whenever possible, you 
should anchor frames before you convert the document. 
Using Frame Filters 7
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Unanchored named frames
The filter will not convert unreferenced named frames in a Ventura Publisher file. Before you 
filter a Ventura Publisher chapter file, make sure to either anchor these frames or remove 
the name of the frame.

International characters

The filter supports chapter files that use the international character set. However, you may 
have problems if the paragraph tag names in the Ventura style sheet use lowercase 
international characters. Before you convert the document, change lowercase international 
characters in the style sheets to uppercase characters. Otherwise, the paragraph tag name 
could be lost, and the paragraph may change to an incorrect format.

Converting document files
The conversion process requires 5 to 10 times more memory or temporary disk storage than 
an original file requires. Before converting a file, make sure you have adequate memory 
and temporary disk space. If you run out of memory or disk space, you can divide the 
original file into smaller pieces, convert the pieces, and then paste the pieces together in 
one Frame document.

To convert a file:

1. Start the Frame product.

2. Choose Open from the File menu in the Frame product.

The Open dialog box appears. 

3. Select the file you want to open and click Open.

The Unknown File Type dialog box appears. 

4. In the Unknown File Type dialog box, select the appropriate application or file format 
and click Convert.

It may take a few moments to convert a large file. When the conversion is complete, the 
Frame document opens.

If the file you convert uses unavailable fonts, Frame products substitute fonts during the 
conversion. If Show File Translation Errors is selected in the Preferences dialog box, 
Frame products display a console window (which may be minimized) listing the font 
substitutions. After the conversion is complete, you can click the icon to open the console 
window to see which fonts were used.

You can control which fonts substitute for unavailable fonts. For more information on 
customizing, see the online manual Customizing Frame Products.

Saving converted documents
After converting a file, you must save the Frame document using the Save As command 
from the File menu. To avoid overwriting the source file, be sure to enter a new name for 
the converted document.
Converting Documents 8
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You may need to touch up the converted document, either to restore lost formatting 
information or to apply formats from an existing Frame document. For details, see 
Chapter 3, “Touching Up Converted Documents.”

How graphics in document files are converted
Graphics that are stored externally are converted only if they are in a supported format.

Resident graphics in a format other than WMF, such as drawings in the application’s native 
format or graphics imported by copying, are not converted.

Embedded graphics in OLE format usually contain a WMF image. If it is present, the WMF 
image is used during conversion. The OLE object itself is not converted.

For a list of graphics formats that Frame products support, see “Graphics formats” on 
page 3.

If a source file references graphics that are in a format Frame products do not support, a 
message that the Frame product cannot import the graphics appears during the conversion. 
In this case, you should open the source file in the source application, save the graphics in 
WMF format (or another supported format), and then convert the file. Alternatively, if the 
source application is a Windows application, you can copy graphics from the source file and 
paste them into a Frame document.

For more details on graphics conversion, see Chapter 4, “Converting Graphics.”

How specific file formats are converted
Because features differ widely from one application to another, not all features in all source 
files can be converted. This section lists formatting issues and conversion limitations specific 
to various applications. 

The applications are listed in alphabetical order.

Ami Pro

This feature Converts this way

Graphics (Ami Pro native format) Not converted. Copy and paste the graphics from the 
original file into the converted document.

Hidden text and summary 
information (owner, date created, 
summary of content)

Not converted.

Index entries Not converted.

Table-of-contents entries Not converted.
Using Frame Filters 9
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Microsoft Word for Macintosh

Microsoft Word for Windows

This feature Converts this way

Files saved with the Fast Save 
option

Not fully converted. For best results, avoid converting 
documents that were saved with the Fast Save option. 
Save them with the regular Save option instead.

Tables (release 4.0 and later) Converted to paragraph text.

This feature Converts this way

Bookmarks, comments, and 
annotations 

Not converted.

Data fields (for merge printing) Not converted.

End-of-section endnotes Converted to footnotes, as are other endnotes.

Extended characters Converted as specified in the Quick Reference for your 
Frame product.

Files saved with the Fast Save 
option

Not fully converted. For best results, avoid converting 
documents that were saved with the Fast Save option. 
Save them with the regular Save option instead.

Hidden text Not converted.

Macro buttons Not converted.

Outline-mode text Converted to regular text.

Proportional spacing Not converted.

Redlining Not converted.

Soft page breaks Not converted.

Summary information (owner, 
date created, summary of content)

Not converted.

Tables of contents and indexes Converted to regular text. You must regenerate tables 
of contents and indexes in the Frame product using the 
Generate/Book command.

Variables, including file-merging 
variables

Converted to hard text.

Single, double, and word 
underlining 

Converted to Frame product single-line underlining.
Converting Documents 10



H o w  s p e c i f i c  f i l e  f o r m a t s  a r e  c o n v e r t e d2 Go To
Rich Text Format (RTF)

Ventura Publisher
You can convert any chapter created with Ventura Publisher release 3.0 or earlier. You can 
also filter release 4.0 files, provided the files don’t include data or objects created by:

• Ventura Scan

• Ventura ColorPro

• Ventura Separator

• Ventura PhotoTouch

• Ventura DataBase Publisher add-on products

If you have problems converting a Ventura Publisher document created with release 4.0 or 
later, save the document as a release 3.0 document and retry the filter. If you save a release 
4.0 or later document to release 3.0, all 4.0 or later features will be lost.

When you convert a Ventura chapter file, the .STY, .VGR, and .CAP files associated with 
the chapter file are converted automatically.

If the message “Unknown error opening file” appears, the filter is unable to locate a support 
file (for example, a style sheet) for the chapter. Make sure the pathnames in the Ventura 
Publisher chapter file correspond to the correct location of each support file.

The filter opens Ventura chapter files only. It will not open publication files. If you have a 
publication file, do the following:

1. Convert each chapter in the publication to a Ventura chapter file.

2. Convert each Ventura chapter file to a Frame document.

3. Create a Frame product book file and add the converted chapters to the book.

See your user’s manual for more information about creating book files.

This feature Converts this way

Bookmarks Not converted.

Data fields (for merge printing) Not converted.

End-of-section endnotes Converted to footnotes, as are other endnotes.

Macro buttons Not converted.

Outline-mode text Converted to regular text.

Tables of contents and indexes Converted to regular text. Use the Frame product 
Generate command to regenerate tables of contents 
and indexes. 

Variables Converted to regular text.
Using Frame Filters 11
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WordPerfect for Macintosh

WordPerfect for Windows

This feature Converts this way

Graphics Not converted because they are stored by a method 
that prevents them from being copied to MS-DOS 
media.

Styles Although styles are converted to Frame product 
paragraph formats, in WordPerfect for Macintosh a 
style begins and then remains in effect until a new style 
is applied. Consequently, a converted document will 
apply the same style to every paragraph until a new 
style is encountered.

This feature Converts this way

Boxes Information in figure, text, user, and table boxes is 
converted, but the boxes themselves are not 
converted.

Equations and formulas Converted to regular text. For example, the square root 
symbol becomes the text sqrt.

Hidden text and summary 
information (owner, date created, 
summary of content)

Not converted.

HLine and VLine Not converted.

Outline-mode text Converted to regular text.

Parallel columns Converted to newsletter-style columns.

References to included files 
created with the Master Doc/
Subdoc feature

Not converted. Expand WordPerfect master 
documents before filtering.

Styles Filter applies the same style to every paragraph until a 
new style is encountered.

WordPerfect characters WordPerfect characters that Frame products do not 
support are converted to the closest matching 
character.
Converting Documents 12
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3 Touching Up Converted 
Documents 3
Frame filters convert as much of a file as possible into Frame format, but some formatting 
features have no equivalents in Frame products. After converting a file, you can touch up 
the new Frame document, either by restoring lost formatting information or by applying 
formats from an existing Frame document. 

This chapter contains basic guidelines for touch-ups as well as tips for touching up specific 
features in converted documents. For more information on how specific file formats are 
converted, see “How specific file formats are converted” in Chapter 2.

Basic guidelines for touch-ups
Generally, you should touch up documents first at the page level, then at the paragraph 
level, and finally at the character level. 

Changes to the page column layout should be made on master pages and then applied to 
body pages. See “Column layout” on page 15.

The easiest way to touch up the overall format of a converted document is by importing 
formats from an existing Frame document or template. 

Ideally, the paragraph format tags in the Frame template should correspond to the 
paragraph names in the converted file. For information on differences in converted tag 
names, see “Tag names” on page 21 and “Tag names” on page 25.

If you used templates to format your original files, you can either convert those templates 
to Frame templates and touch them up, or you can create new Frame templates with the 
page layouts, headings, and paragraph formats you want. For more information on setting 
up custom templates, see your user’s manual.

Follow these general steps for importing formats from templates:

1. Convert the files.

2. Open the templates you want to use.

3. In the converted documents, choose the Import>Formats command from the File menu 
to apply the formats from the templates. 

For more information on using formats from other sources, see your user’s manual.

To import an existing format into multiple converted documents, build a Frame book that 
includes all the converted documents. Then, with the book window active, use the 
Import>Formats command in the File menu. For more information on grouping 
documents into a book, see your user’s manual.

The rest of this chapter contains tips for specific touch-ups, in alphabetical order.
Using Frame Filters 13
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Absolutely positioned graphics
Absolutely positioned graphics are an application’s equivalent to Frame unanchored frames. 
They are attached to a specific page instead of to a specific piece of text. In a converted 
document, absolutely positioned graphics are converted to anchored frames, so they may 
appear in slightly different locations than in the source file.

Whenever possible, before you convert a file you should change absolutely positioned 
graphics to floating graphics, which are an application’s equivalent to Frame anchored 
frames. They are attached to a specific piece of text instead of to a specific page.

Automatic text-wrap around graphics
Frame products do not support automatic text-wrap around graphics. If you use this feature 
extensively, converted documents will not retain much of their original look and will require 
some manual revision. For more information about flowing text around a graphic, see your 
user’s manual.

Bulleted paragraphs
In some applications, outdented bulleted paragraphs are created using side-by-side 
paragraphs. In others, outdented bulleted paragraphs are created by manually adding a 
bullet character to each paragraph and adjusting tab and indent settings. In Frame products, 
outdented bulleted paragraphs are created by applying Indents, Tab Stops, and Numbering 
properties to a paragraph format. 

When side-by-side paragraphs are used, the filters convert the bullet character, but you 
need to re-create the outdent in the converted document by adjusting the Tab Stops and 
Indents settings for the paragraph. After adjusting the settings, add a tab character after the 

Outdented bulleted 
paragraphs
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bullet character. The following illustration shows typical tab and indent settings for an 
outdented paragraph.

When manually added bullet characters are used, you’ll need to create and apply a Frame 
bulleted paragraph format in the converted document. You’ll also need to delete the 
manually added bullet characters.

For more information on formatting paragraphs, see your user’s manual.

Column layout
Most filters use the first column layout setting in the source document to create right and, 
if necessary, left master pages. (An exception is the Ventura Publisher filter.) Other column 
layout settings are stored in other master pages that you can use to touch up documents 
that have more than one column layout. As shown in the following illustration, the filters 
convert column changes that occur on a single page into two master page layouts. 

Left indent 
symbol

First-line indent 
symbol

Left tab symbol

First setting in 
source file

First setting in 
source file

Frame filter

Frame filter

Right 
master page

Left 
master page

1-column master 
page

Right 
master page

Left 
master page

2-column master 
page
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The following tips apply to touching up the column layout in converted documents:

• Although it is possible to create column layouts on body pages, you should create the 
layouts on master pages and then apply the master pages to the appropriate body 
pages.

For details on laying out and applying master pages, see your user’s manual.

• It is easier to touch up converted documents that have more than one column layout 
if the most frequently used column layout is the first one used in the source file. Before 
converting, change the column layout in the source file. Later you can correct the 
layout in the converted document.

Be sure to apply a flow tag to each new body text column you place on a master page. 
Use the Flow command on the Format menu. Do not apply flow tags to header and 
footer text columns. For more information on flows, see your user’s manual.

• After you finish touching up the document, delete any unapplied master pages.

Cross-references
The filters do not convert cross-references. You’ll need to re-create cross-references in 
converted documents using the Cross-Reference command. For more information on cross-
references, see your user’s manual.

To help you see where cross-references are missing, some filters insert the message 
<Reference> and insert a Comment marker. You can use the Find/Change command to 
search for the message or the marker in the converted document. For information on finding 
markers, see your user’s manual.

Drop caps
Frame products convert drop cap characters to the default character format of the current 
paragraph. 

To achieve the drop cap character effect in Frame products:

1. Using the Tools palette and the Character Designer, create a large character in the 
desired position inside the text column on top of the text.

2. Use the Split Current Column pop-up menu on the Layout palette to split the text 
column into two parts.

3. Resize the columns so they surround the large character.

4. Reposition the large character, if necessary.

For information on custom flow design, adding a text line, and flowing text around a graphic, 
see your user’s manual.
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The following illustration shows what the Frame product drop cap character effect looks like.

Equations
Equations created with other applications are not converted to Frame equations. Instead, 
they are either converted to text or imported as graphics.

You need to recreate the equations using FrameMath™, the Frame equations editor. For 
information on creating equations, see your user’s manual.

To help you see where equations are missing, some filters insert a Comment marker and 
the message <Insert Equation Here>. You can use the Find/Change command to search 
for the message or the marker in the converted document. For information on finding 
markers, see your user’s manual.

Headers and footers
Only the first header and first footer from the source file are applied to the converted 
document. The text of other headers is stored on a master page called Headers. The text 
of other footers is stored on a master page called Footers. 

To restore running headers and footers to the converted document, set them up as 
described in your user’s manual. You may copy and paste text from the Headers and 
Footers master pages if you wish. You may wish to delete the Headers and Footers master 
pages after you set up running headers and footers.

Imported files
Do not use the Frame product Import command to import a document file created with 
another application into an existing Frame document. Instead of importing the file, follow 
these steps:

1. Convert the file you want to import by opening it in the Frame product.

2. Use the Copy or Select All in Flow command to copy all of the converted document.

3. Paste the selection into the target Frame document.

For details on selecting, copying, cutting, pasting, and deleting text, see your user’s 
manual. 

Large 
character 
created with 
Text Line
tool

Text columns split and 
resized to fit around 
large character
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Index entries
The filters convert most index entries to Frame index markers. (An exception is Ami Pro 
index entries, which are not converted.) However, you’ll need to use the Generate/Book 
command to regenerate the index after the file is converted. Some applications allow you 
to format the index marker text. Frame filters do not convert this type of formatting.

For information on generating indexes, see your user’s manual.

Overflowing text columns
If text flows into unconnected columns, it may overflow at the end of the column after 
conversion. An overflow occurs when a column has more text than it can hold. If you see 
a solid black line at the bottom of a column when borders are turned on (with the 
View>Borders command), the column contains overflowing text. This text is only hidden 
from view; it is not deleted. For more information on overflows, see your user’s manual.

Page breaks
If page breaks need adjustment, use the Pagination properties in the Paragraph Designer. 
For more information on page breaks, see your user’s manual. 

Rotated text
Frame filters convert rotated text to nonrotated text. You can use the Rotate command to 
rotate a text column or a text line clockwise and counterclockwise in 90-degree increments.

When you rotate a text column in a Frame product, all text in the column is rotated. 
Therefore, after you convert the document to Frame format, you’ll have to create separate 
column layouts on the body pages where you want to place rotated text.

Alternatively, you can re-create the text with the Text Line tool in the Tools palette and rotate 
the text line instead of the column. The rotated text line will be absolutely positioned on the 

The black line 
shows that this 
column contains 
overflowing text.
Touching Up Converted Documents 18



S i d e  h e a d i n g s3 Go To
page unless you anchor it to the text. For more information on creating anchored frames, 
see your user’s manual.

Side headings
In some applications, you can use line breaks to create side headings in the margins. Side 
headings do not appear in converted documents. Instead, paragraphs that use line breaks 
line up one below the other. For information on placing side headings or notes in the margin, 
see your user’s manual.

Straddled text
Some applications allow you to place text, such as a headline, in one column of a multi-
column layout that extends across the other columns. When converted, this text no longer 
straddles columns. 

To achieve the straddled text effect in Frame products, create a new master page with a 
separate text column for the straddled headline and then apply the new master page to the 
body page as shown below. For more information on laying out master pages and on 
controlling the flow of text, see your user’s manual.

Separate column 
for rotated text

Separate 
column for 
straddled text
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Tab stops
Frame tab stops are absolute rather than relative. If the tab stops in the files you’re 
converting are relative, you will need to modify tab settings, especially in tables. 

Relative tab stops are like those on a traditional typewriter. When tab stops are relative, the 
insertion point moves to the next tab stop each time you press Tab. For example, the 
insertion point in the following illustration moves to the beginning of column 3 when you 
press the Tab key because the insertion point is already to the right of the first tab stop.

In contrast to relative tab stops, Frame’s absolute tab stops cause the n th tab on a line to 
move the insertion point to the n th stop. Because they are absolute, you must press the 
Tab key twice to move the insertion point to the beginning of column 3, as shown in the 
following illustration.

 

If the original document has one tab stop per column, you might occasionally need to add 
tab characters in the converted document to ensure that the insertion point advances to the 
appropriate column. If the document has more tab stops than needed in a tab-delimited 
table, you must either add tab stops in the converted document or delete the extra tab 
characters in the converted text.

To change tab stops, use the Tab Stops settings in the Basic properties in the Paragraph 
Designer, or change the tab stops in the ruler.

Second tab stop

First tab stop

Left margin

Tab symbol

Tab key pressed once

New position of insertion point

New position of insertion point

Tab key pressed twice
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After you convert a document, you might need to delete unwanted tab stops. As shown in 
the following illustration, occasionally the first tab stop in a paragraph converts as aligned 
with the first indent instead of being positioned a distance to the right of the indent.

To correct the tab alignment, delete the first tab stop either from the ruler or in the Basic 
properties in the Paragraph Designer. When you’re satisfied with the tab settings, update 
all paragraphs with the same tag.

The corrected tab stop settings are shown in the following illustration.

For more information on setting tabs, see your user’s manual.

Tables of contents
Frame filters do not translate table-of-contents entries. You must regenerate the table of 
contents using the Frame product Generate/Book command. For more information on 
generating a table of contents, see your user’s manual.

Tag names
Frame filters enter all paragraph styles into the converted document’s Paragraph Catalog, 
but they do not enter character styles into the Character Catalog. All tag names are case-
sensitive, and the converted document’s Paragraph Catalog entries match the style names 
used in the source file. 

The filters apply paragraph tags based on the first style encountered in a given paragraph. 
Any subsequent styles encountered in the same paragraph are converted to local format 
overrides.

Uncorrected tab 
stop settings

Corrected tab stop 
settings
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Because some applications allow you to create two different styles with the same name, 
collisions between styles can occur. When a collision occurs, the filters apply local format 
overrides to subsequent paragraphs with the same style name but different settings. To 
correct local overrides of font settings, select the whole paragraph and click Default ¶ Font 
in the Character Catalog. If necessary, reapply the format from the Paragraph Catalog.

You may need to change the names of some paragraph tags. For information on how to 
change the name of a paragraph tag, see your user’s manual.

Text spacing
If you need to make fine adjustments to the spacing of text in a column, use the Feather 
setting in the Flow Properties dialog box. With feathering, Frame products adjust the 
spacing between lines and paragraphs so that the last line of a text column reaches the 
bottom of the column. For more information on feathering, see your user’s manual.

Ventura Publisher documents
The following items apply only to the Ventura Publisher filter.

Frames

Duplicate references to an anchored frame
The filter does not convert multiple references to the same anchored frame. The first 
occurrence of the frame is converted, but additional occurrences are not. After you convert 
the document, you can copy the anchored frame and paste it in the locations where it was 
referenced.

To help you see where a frame is missing, the filter inserts a Comment marker and the 
message <Duplicate Anchor - anchor name>, where anchor name is the name of the 
referenced anchor. You can use the Find/Change command to search for the marker in the 
converted document. For information on finding markers, see your user’s manual.

Repeated frames
If a repeated frame appears on both the left and right master pages of the Ventura Publisher 
chapter file, only the frame contents on the right master page are converted. The frame on 
the left master page is converted but not the contents of the frame. The filter inserts the 
message <Repeat From Right>. To correct this problem, you can copy the contents of the 
frame on the right master page and paste it in the empty frame on the left master page.

Publication files
Ventura publication files are like Frame book files. They contain pointers to a series of 
chapter files. The filter converts only chapter files; it doesn’t convert publication files to book 
files. If you have a publication file, use the filter to convert each chapter file in the publication 
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separately. Then create a Frame book file and add the converted chapters to the book. For 
more information on creating book files, see your user’s manual.

Ruling
Ventura Publisher lets you place ruling around paragraphs and text columns. Boxes around 
tables are converted. Other ruling conversions are as follows:

Ruling above or below a paragraph

Ruling above or below a paragraph is converted. Frame products store ruling in a reference 
frame. For more information on reference frames, see your user’s manual.

Ruling around a paragraph

The top and bottom ruling in a box is converted to ruling above and below the paragraph. 
The ruling on the left and right sides of the box is not converted. 

To re-create a box in a Frame product:

1. Use the Insert Table command to create a table that has one row and one column.

2. Copy the paragraph text into the table cell.

3. Use Ruling properties in the Table Designer to add ruling to the outside of the table.

For more information on tables and table ruling, see your user’s manual.

Ruling around text columns

Ruling around text columns is converted. In Frame products, ruling is drawn around the text 
column with the Polyline tool. For more information about polylines, see your user’s manual.

Sequence numbering
Sequence numbering for chapter, figure, and table references is not converted. You’ll need 
to re-create these numbers using Frame cross-references. For information, see your user’s 
manual. To help you see where sequence numbers are missing, the filter inserts the 
following text:

The filter also inserts a Comment marker. You can use the Find/Change command to search 
for this marker in the converted document. For information on finding markers, see your 
user’s manual.

Type of sequence number Text

Chapter <C#>

Figure <F#>

Table <T#>
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Tables

Custom ruling and shading
The filter does not convert custom ruling or shading for table cells. You need to use the 
Custom Ruling & Shading command to create the same effect in the converted document. 
For more information, see your user’s manual. The filter does convert ruling that applies to 
an entire table (for example, a box around the table).

Straddles
The filter does not convert straddled columns or rows in tables. You need to use Frame’s 
Straddle command on the Table menu to re-create the straddles in the converted document. 
To help you locate cells that are no longer straddled, the filter inserts a plus symbol (+) if 
the cell should be straddled with the cell on the left. The filter inserts a caret symbol (^) if 
the cell should be straddled with the cell above. 

Table width
In Ventura Publisher, not all tables have explicit widths. For example, some tables vary in 
width depending on the size of the frame that contains the table. For tables without explicit 
widths, the filter automatically sets the width to 1 inch per column. For a table with just a 
few columns, the converted table may be narrower than the original table. For a table with 
a large number of columns, the converted table may be much wider than the original table. 
To adjust the width of the table in a Frame product, select the table and choose Resize 
Columns from the Table menu. For more information, see your user’s manual.

Table after 
straddles are fixed 
in the converted 
document

Indicates cell 
should be 
straddled with 
cell on left

Indicates cell 
should be 
straddled with 
cell above
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Tabs

Ventura Publisher documents have both enabled and disabled tab stops. The filter converts 
enabled tab stops and removes disabled tab stops. The filter deletes tab stops that are not 
greater than the previous tab stops. For example, in a Ventura Publisher chapter that has 
three numbered tab stops—tab stop 1 at 1 inch, tab stop 2 at 3 inches, and tab stop 3 at 
2 inches—only tab stops 1 and 2 appear in the converted document.

Tab stops are not numbered in Frame products. The tab sequence for a paragraph starts 
at the left margin and continues sequentially to the right. 

If the headers and footers do not line up properly in a converted document, you may need 
to update the tab stops in the header and footer paragraphs on the converted document’s 
master pages. 

For more information on adding and deleting tab stops, and information about master pages, 
see your user’s manual.

Tag names
Frame products are case-sensitive. Paragraph tag names from the Ventura Publisher style 
sheet are converted to initial caps in Frame products. Here are some examples:

If you don’t like the new name, you can change it. For information on how to change the 
name of a paragraph format, see your user’s manual.

Uppercase international characters, such as È, are not converted to lowercase. For 
example, the style sheet name BULLÈT is converted to BullÈt instead of Bullèt. The filter 
does not support lowercase international characters in the style sheet.

Unanchored frames

Because of differences in font metrics, paragraph spacing, and so on, unanchored frames 
may appear in slightly different locations after a document is converted. Whenever possible, 
you should anchor frames before you convert the document. After you convert the 
document, check for any unanchored frames that are not in their correct locations.

Ventura Publisher name Frame product name

LargeFigure Largefigure

LARGEFIGURE Largefigure

largeFIGURE Largefigure

Large figure Large Figure

LARGE FIGURE Large Figure

LARGE_FIGURE Large_Figure
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Vertical alignment
Frame products do not support vertical alignment of text within a text column. To adjust the 
position of text in a column, use the Space Above and Space Below settings in the Basic 
properties in the Paragraph Designer. For more information, see your user’s manual.
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4 Converting Graphics 4
This chapter describes the basic steps for converting graphics. It also contains information 
about graphics filter initialization files (.ini files), which you can edit to customize the 
behavior of some of the graphics filters.

Before they can be converted, graphics must be in a format that Frame products support. 
For more information on graphics, see the following sections of this manual:

• For a list of supported graphics formats, see “Graphics formats” on page 3.

• For tips on preparing graphics in Ventura Publisher files, see “Preparing graphics files” 
on page 7.

• For details on graphics conversion, see “How graphics in document files are 
converted” on page 9.

Basic graphics conversion steps
You convert graphics by importing them into a Frame document. 

1. Start the Frame product and open a Frame document.

2. Place the insertion point where you want the imported graphic to be placed.

3. Choose Import>File from the File menu.

The Import dialog box appears. 

4. Choose the graphics file to import and the import method.

5. Click Import.

The graphics file is converted and copied into an anchored frame at the location of the 
insertion point in the Frame document. 

If you’re importing a bitmap, a dialog box appears so you can specify the bitmap’s scale.

When borders are set on (with the Borders command on the View menu), they may obscure 
the outermost pixel of an imported image file. If the edge of a picture appears truncated, 
turn borders off to make the entire graphic visible.

About graphics filter initialization files
Some Frame graphics filters make use of graphics filter initialization files, which contain 
default settings and filter-specific settings for items like profile definition, font mapping, and 
color mapping. You can change some of the settings in the initialization files to customize 
a filter’s behavior.
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Graphics filter initialization files are located in the directory where your Frame product is 
installed and they have the file extension .ini.

Initialization file structure
An .ini file contains a header section and profile sections. Each profile section contains a 
group of related settings. Sections and settings have the following format:

[section_name]
setting_name=value

The [section_name] statement is the name of a section. The enclosing brackets ([ ]) 
are required, and the left bracket must be in the leftmost column on the screen.

The setting_name=value statement defines the value of each setting. A setting_name 
can be any combination of uppercase or lowercase letters and digits, and it must be 
followed immediately by an equal sign (=). The value of the setting can be an integer, a 
Boolean value, a string, or a string in quotation marks, depending on the setting. There are 
multiple settings in most sections.

To enable a Boolean setting, set the value to: True, Yes, On, or 1. To disable a Boolean 
setting, set the value to: False, No, Off, or 0. Certain Boolean settings are limited to 
numerics or certain text.

You can include comments in initialization files. Begin each line of a comment with a 
semicolon (;).

This manual lists .ini settings alphabetically, but settings do not necessarily appear 
alphabetically in a specific .ini file. To change a setting, you need to search for it in the 
appropriate section.

Reading the [FILTER_NAME] section
The [FILTER_NAME] section is always the first block in an initialization file. All settings in 
the [FILTER_NAME] section are required. If you modify or delete one of these settings, the 
filter will not work properly. There are no specific default values for these settings; values 
are assigned based on individual filter requirements.

Section or Setting Name Description

[FILTER_NAME] Specifies the internal name for this filter DLL. 

Example: 
[IM_CGM]

~Default Mode=string Specifies the name of the profile to use if the ~Mode section 
is deleted. The default varies from filter to filter; usually it is 
Standard Options.

Example: 
~Default Mode=Standard Options
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Reading the [Profile] section
The number of [Profile] sections in an initialization file may vary. Each [Profile] 
section contains settings that are used when the profile is selected as the current ~Mode. 
The [Profile] section can contain the following settings, but may also contain additional 
settings that are defined in the individual filter's documentation.

~Header=string Specifies the text used as the caption on the setup dialog (if 
available) for editing this .ini file. The default varies from 
filter to filter; usually it is Standard Options.

Example: 
~Header=CGM Import Filter Setup

~Mode=string Specifies the current profile. The default varies from filter to 
filter; usually it is Standard Options.

Example:
~Mode=Standard Options

Profile=
FILTER_NAME.mode

There may be up to 32 profiles for the filter. Each profile has 
a setting in this block and a corresponding section that 
defines the specific settings for the profile. 
Profile specifies name of the profile; mode is the driver 
mode for the profile. The first character of the profile name 
must be an asterisk (*) if the profile is to be editable in the 
setup dialog.

Noneditable example:
Standard Options=IM_CGM.0

Editable example:
*ImageMark - Binary=IM_CGM.16

Section or Setting Name Description

ColorTableSource=
string

Determines which source is used to set the color table. If set 
to FILE, the filter will use the color table contained in the file 
to determine indexed color values. If set to PROFILE, the 
filter will use the color table information included in this 
profile section. Default is FILE.

Example:
ColorTableSource=FILE

DefaultFileSpec=
path-searchstring

This is an optional field that is not used by the filter. 
However, CreateSetup() returns this value so that the 
application can use the information with the search string 
and to read or write files on the specified directory.

Example:
DefaultFileSpec=c:\ims\*.pcx

Section or Setting Name Description
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Guidelines for editing initialization files
• Make backup copies of .ini files before making any changes so that you can restore 

the original file if necessary. Change only the settings described in this document. 
Changes made to other settings could cause a filter to fail.

• To change settings in an .ini file, use a text editor to open and edit the file. If you 
use your Frame product to edit the file, be sure to save the file in Text Only format. 

• Do not save .ini files in Frame Normal format or in any other word processor format.

Driver=
FILTER_NAME.mode

The mode indicates the subtype of files this profile supports. 
Not all filters support multiple subtypes. In all cases, the 
filter selects the appropriate subtype if ~Mode=Standard 
Options.

Example:
Driver=IR_BMP.1

Color[Index]=
(rval, gval, bval),"Name"

There may be up to 256 color-mapping entries in the 
[Profile] section. Index is a three-digit number 
between 000 and 255. The first entry must be 000 and each 
succeeding entry must be numbered consecutively (for 
example, 001, 002, and so on). The color values (rval, 
gval, and bval) correspond to red, green and blue 
intensities and must be in the range of 0 to 255. "Name" can 
be any name for the color, with a maximum length of 14 
characters.

Examples:

Color[000]=(128,128,128), "Gray"

Color[001]=(0,0,0), "Black"

Color[002]=(0,0,128), "Dark Red"

Font[Index]="Fontname",
"Description"

There may be up to 32 font-mapping entries in the 
[Profile] section. Index is a three-digit number 
between 000 and 032. The first entry must be 000 and each 
succeeding entry must be numbered consecutively (for 
example, 001, 002, and so on). "Fontname" is the name for 
the font used in files of the particular format, or a null string 
if the format only uses indices. "Description" is a 
Windows-compatible font description of the form 
Family:TypefaceAttributes. The maximum length 
for "Fontname" and "Description" is 62 characters.

Examples:

Font[001]="Sans Serif 
Bold","Swiss:Helvetica Bold"

Font[002]="","Roman:Times Italic"

Section or Setting Name Description
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• After changing an .ini file, you need to restart the Frame product to activate the 
new settings.

Graphics filters that you can customize
The following sections contain descriptions of the graphics filters that have .ini files you 
can edit. In the descriptions, common .ini settings are those that can appear in any .ini 
file and special .ini settings are those that appear only in that filter’s .ini file.

AutoCAD Drawing Interchange Format (DXF)

Computer Graphics Metafile Format (CGM)

Description Import filter for Autodesk AutoCAD vector file format.

Release identifier DXF release 12.0.

Coordinate system Real values with origin (0,0) at the bottom left corner.

Scaling mode Abstract.

.ini file IMDXF9.INI
The default option uses 256 color-mapping. You can select 
profiles for 8-color or 16-color modes.

Common .ini settings [IM_DXF]
Color Mapping
ColorTableSource
Font Mapping

Special .ini settings None.

Notes Only one viewport is imported from multiple-viewport DXF files. 
The filter sets the marker type to plus.

Description Import filter for hybrid file format (vector and raster) used by 
many popular graphics software products.

Release identifier CGM release 1.

Coordinate system Integer or real values.

Scaling mode Abstract or metric with scale factor.

.ini file IMCGM9.INI

Common .ini settings [IM_CGM]
Color Mapping
ColorTableSource
Font Mapping

Special .ini settings None.
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CorelDRAW Drawing File Format (CDR)

Digital Research Graphic File Format (GEM)

Notes Generalized Drawing Primitive, Escape, and Application Data 
are supported in ImageMark mode only. Some CGM profile files 
have no background color encoded into the file. The filter 
defaults to (170, 170, 170) Gray. You can override this in 
the IMCGM9.ini file with the Color[0 0 0] setting. For 
example, Color[0 0 0]=(0, 0, 0) sets background to 
black.

Description Import filter for CorelDRAW hybrid file format (vector and 
raster).

Release identifier CDR release 3.0.

Coordinate system Positive integers with origin (0,0) at the center of the page.

Scaling mode Metric (1200 dpi).

.ini file IMCDR9.INI

Common .ini settings None.

Special .ini settings None.

Notes Rotated rounded rectangles are emulated using Circular Arc 
Center. Extruded object groups and vector fill patterns are not 
fully supported. The following are not supported: text, spot 
colors, envelope editing and perspective editing, bitmaps, 
arrowheads, OLE objects, line scaling, and character kerning.

Description Import filter for Digital Research product vector file format.

Release identifier GEM release 3.0.

Coordinate system Integers with origin (0,0) at the bottom left or top left corner.

Scaling mode Metric or abstract.

.ini file IMGEM9.INI

Common .ini settings [IM_GEM]
Color Mapping
ColorTableSource
Font Mapping

Special .ini settings None.
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Hewlett-Packard Graphics Language (HPGL)

Macintosh QuickDraw File Format (PICT)

Description Import filter for Hewlett-Packard plotter vector file format.

Release identifier HPGL/2

Coordinate system Integers or real values with origin (0,0) at the bottom left corner.

Scaling mode Metric.

.ini file IMHGL9.INI

Common .ini settings [IM_HGL]
Color Mapping
ColorTableSource
Font Mapping

Special .ini settings You must be using the standard .ini file to use special 
settings. 
Plotter model number (for default viewport size) is:
~Mode=PLOTTER MODE OPTION
Default is Standard Options. With different plotter mode 
options, the page size can be changed so you can import HPGL 
files that do not contain the Page Size command. The plotter 
mode and the corresponding page sizes are shown below. 
Standard Options (0, 0) to (12000, 9000)
HP7090 (–333, –100) to (10703, 7987)
HP7440/70 (0, 0) to (10300, 7650)
HP7475 (0, 0) to (10365, 7962)
HP7510/50A (0, 0) to (16344, 10896)
HP7570A (–10576, –7556) to (10576, 7556)
HP7580/85/86 (–3238, –4988) to (3238, 4988)
HP7595/96 (–4948, –3198) to (4948, 3198)
PRESCAN Finds an approximate bounding box by 
prescanning the file.

Notes Polyline encoding and Color Table commands are not 
supported.

Description Import filter for hybrid file format (vector and raster) used by 
Apple Macintosh products.

Release identifier PICT releases 1.0 and 2.0.

Coordinate system Integers with origin (0,0) at top left corner.

Scaling mode Metric (72 dpi).

.ini file IMPCT9.INI
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Micrografx Drawing File Format (DRW)

WordPerfect Graphic File Format (WPG)

Common .ini settings [IM_PICT]
Color Mapping
ColorTableSource
Font Mapping

Special .ini settings None.

Notes Pen size in a PICT file has height and width. The filter considers 
the larger of these two values to be the pen size. Regions are 
not fully supported. Line patterns, comments, and clip regions 
are not supported.

Description Import filter for Micrografx products hybrid file format (vector and 
raster).

Release identifier DRW release 2.0
Symbol release 4.0.

Coordinate system Positive integers with origin (0,0) at top left corner.

Scaling mode Metric or variable dpi.

.ini file IMDRW9.INI

Common .ini settings [IM_DRW]
Color Mapping
ColorTableSource
Font Mapping

Special .ini settings None.

Notes File is prescanned to build a 256-element color table. Primitives 
in invisible layers are not supported. Rotated rectangles are 
emulated with polygons. Rotated rounded rectangles are 
emulated with elliptical arcs in a figure. Labeled lines are 
emulated with a line and a text string. Invisible lines are not 
supported. Release 1 files are not supported.

Description Import filter for WordPerfect products hybrid file format (vector 
and raster).

Release identifier WPG release 1.0.

Coordinate system Positive integers with origin (0,0) at bottom left corner.

Scaling mode Metric (1200 dpi).

.ini file IMWPG9.INI
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Common .ini settings [IM_WPG]
Color Mapping
ColorTableSource
Font Mapping

Special .ini settings None.

Notes WPG does not differentiate between Edge attributes and Line 
attributes. WPG files can contain several word processor text 
commands such as those that set justification and margins. 
These are not converted. All patterns are translated as bitmap 
patterns. Rotated bitmaps are not supported.
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